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Requirements
discQuest requires an Apple IIGS computer with:

2 M B R A M
3.5" floppy disk drive
S C S I I n t e r f a c e C a r d
CD-ROM Drive & proper cables
System Software 6.0 or higher (only if using a hard disk)

A color monitor is required to view color pictures, but not required if
you only use the gray-scale (black and white) imaging features. A
hard disk dr ive is recommended but not required. The System
Software provided on the Diskette Svstem is System 6.0.1.

I n s t a l l a t i o n

H a r d w a r e I n s t a l l a t i o n

If you are instal l ing a complete discQuest bundle, refer to the
RamFAST™ manual that came wi th your d iscQuest bundle for
information on installing the RamFAST card and attatching the CD-
R O M d r i v e t o i t .

IMPORTANT: If you are adding a CD-ROM to an existing SCSI card
make sure that your boot hard drive's SCSI ID is higher than that
of the CD-ROM. The discQuest CD-ROM Drive comes factory preset
with SCSI ID #I so you should not have to modify it, but other CD-
ROM drives may be set at #4,#6, or others. Refer to your CD-ROM
D r i v e m a n u a l f o r i n f o r m a t i o n o n h o w t o c h a n g e t h e S C S I I D .

For discQuest users without a hard disk drive, you will probably
want to make sure that your computer always boots from the 3.5"
disk drive. To do this, enter the IIGS Control Panel (press the Control,
Apple, and ESC keys simultaneously). Use the arrow keys to highlight"(Control Panel" and press the Return key. Use the arrows again to
highlight "Slots" and press Return. The bottom of the Control Panel
window should now have an item "StartUp". Use the arrow keys to
make sure this option is set to "Slot 5" (left and right arrows will
change the setting). Once StartUp is "Slot 5", press the Return key.
You can now reboot the computer and it will start up from Slot 5 (the
IIGS's 3.5 inch floppy disks). This is necessary because the IIGS
cannot boot from the types of CD's discQuest works with.
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S o f t w a r e T n s t a l l a t i o n

discQuest uses Apple's Installer program for trouble-free installation
of discQuest on a hard disk drive. If you do not have a hard drive,
all you have to do is boot the floppy labelled Diskette Svstem.

To install discQuest on a hard drive, boot your hard drive to the
"Finder" program, then insert the Hard Disk Installer disk into any
3.5" drive. A window should open with the contents of the Hard Disk
Installer disk. (If a window does not open automatically, double-click
on the "discQuest" disk icon to open it). Then run the Installer
program by double-clicking on its icon.

Once you are in the Installer, choose from the left hand side of the
window the installation you wish to perform. There are versions for
System Software 6.0, and 6.0.1 (each have slightly different device
drivers which can't be mixed). Once you choose which System
Software you are installing discQuest into, the right side of the
window will allow you to choose a directory to place the actual
discQuest application program in.

Clicking the "Install" button will begin the installation. The following
files will be copied to your System folder:

F o n t s / C o P i l o t . 8

F S T s / H S . F S T

a n i c e m o n o s p a c e f o n t b e s t s u i t e d f o r
displaying text off of the discQuest CD's
a "File System Translator" which helps your
I I G S r e a d t h e I S O 9 6 6 0 C D - R O M f o r m a t

IMPORTANT: the Insta l ler does not copy the necessary devic t
drivers for your SCSI card onto your hard drive. If you have a
RamFAST, no additional drivers are necessary. For an Apple SCSI
card, you need to install the "SCSICD.Driver". Choose "Drive: CD-
ROM" i n t he Sys tem So f twa re Ins ta l l e r p roc ram.

The application will be copied into the directory you specified. You
should now reboot your computer to make sure the new System files
a r e l o a d e d a n d a c t i v e .

If you run into a problem installing the RamFAST card or CD-ROM
drive, call Sequential Systems toll-free technical support and we'll be
happy to help you.
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Startup and Browsing
When you run discQuest, it scans all available drives for a CD-ROM
device. Then it checks to see if the CD-ROM contains a DiscPassage™
or other recognizable CD. When a usable CD has been found,
discQuest opens up the "Browse" window.

The Browse window lets you view the contents of the CD in "catalog"
o r " Ta b l e o f C o n t e n t s " f o r m a t . S i n c e C D - R O M s o f t e n c o n t a i n h u n d r e d s
of megabytes of data, the information is broken down into categories
and sub-categories, much like subdirectories on a hard disk drive. In
fact, discQuest represents subcategories with a folder icon just like
that used by the Finder™.

C=i Questions Rnsthrs
Educotional Resources Support Groups

CD Health Update Booklets
C D I l l u s t r a t i o n s
CD The Consuier Guide (R) to Prescription Drugs
CD flnotoag of the Hunan Bodg
T Glossary of Body Ports

■ ■ frJiiH' liy _ 0 A lii (1 m
O

i l l

Text documents are represented wi th a 'T ' i con, p ic tures are
represented with a 'P' icon, and audio samples are represented by a
loudspeaker icon. (Audio playback is not universally supported in
discQuest 1.0, see Appendix C for details).

Double-clicking on an item, or selecting the 'Open' menu item will
view or play the item.

At the top of the Browse window are three buttons: Search, Back, and
Top. If you've opened several categories and want to go back to the
previous one, click the 'Back' button. If you want to go all the way
back to the main table of contents, click the 'Top' button.
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Clicking the 'Search' button will allow you to search one of up to four
indexes, in the main category you have selected or opened. Each
main category can (but isn't required to) have its own separate index
files. For instance, if a CD had main categories of "Novels" and
"Poems", selecting "Poems" and clicking "search" would only scan the
indexes assoc i a ted w i t h t he Poems , no t t hose w i t h Nove l s . Th i s
separation of indices usually occurs only at the top level of a CD.

The fol lowing keypresses can be used to navigate the Browse
w i n d o w :
<Return> Open Item
A p p l e - 0 O p e n I t e m
< A r r o w s > S e l e c t I t e m
E S C G o b a c k o n e l e v e l ( s a m e a s " B a c k " b u t t o n )
Apple-ESC Go back to top level (same as "Top" button)

S e a r c h

The Search window appears when you click the "Search" button in
the Browse window. The Search windows contains the following
e l e m e n t s :

Hon Does a Doctor Detenaine the Cause of Crozg Behovior?
Understanding Results of the Spinol Top

* Whot Causes o Child to be Dizzg? Con it he Dangerous?
» Could Frequent Heodoches Heon o Brain Tunor?
Hoh Do Doctors Tell One Type of Headache Froa the Other?

» Doesn't AIDS (llso Howe Effects on the Hervous Sgsten?

Typing a word into one of the Search Key fields and pushing the
" S e a r c h " b u t t o n w i l l s e a r c h t h e r e l e v a n t i n d e x f o r a l l fi l e s t h a t
contain that word. There are often several indices you can search.
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selectable by the square "pop-up" menu (labelled "Words" in the
w i n d o w a b o v e ) ;

Words - searches a l l words in a l l documents in th is index

Subjects - searches only the subject sununary keywords
Titles - searches only document titles
Authors - searches only "author" fields in the documents

Note that not all CD's have all four of these indices. If you search on
an index that a particular CD does not have, discQuest will display an
error message, cancel the search, and allow you to try a different
i n d e x .

You choose the index to search by selecting it from the pop-up menu
to the right of the "Search" button.

When the search is complete, the number of documents that are
selected appears in the middle left of the Search window. If this
number is less than twenty (20), the titles of the documents are
automatical ly displayed in the l ist at the bottom of the Search
window. If there are more than twenty, you must manually click the
"Titles" button to get a list of matching titles. You may also enter
another search word into the second "Search Keys" field to narrow
the sea rch . On ly documen ts tha t con ta in bo th words w i l l be
s e l e c t e d .

Once you have a list of matching titles, you may select a document to
view by using the arrow keys or the mouse, and clicking the "Read"
button (or pressing the <Return> key).

Viewing Documents
Much of the time, documents that are listed in the Browse and Search
windows are "text files"; that is, they contain English text, tables, etc.
These documents are displayed with the standard "TextEdit" tool.

To facilitate using data from discQuest in your own work, you can use
the items in the Edit menu to copy data from a document into the
clipboard. Simply use the mouse to select the data you want to copy,
and choose "Copy" in the Edit menu. You may also save the entire
document to a text file on disk by using the "Save As..." item in the
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File menu. You'll be asked for a filename and to pick the disk and
directory where to save the file with a regular Standard File dialog.

Printing a document is as simple as choosing "Page Setup" from the
File menu to make sure your printer sett ings are correct, then
choosing "Print" from the File menu. (See Appendix A for information
on printer drivers).

When a text document is being viewed, one or both of the following
new menus will appear:

F i n d
R e l a t e d I t e m s

The Find menu allows you to search the current document for a word
or words. For ^instance, say that you had searched a database for
"agrarian" and you had found and opened a large document. To find
the part icular reference, s imply choose "Find", enter the word
"agrarian", and press <Return> (or click the "Find" button). The
contents will jump to the word (if it is in the text) and highlight it.

To search for further occurrences of the word, use "Find Again" (or
Apple-G). Each reference that is found will be highlighted in red.

The Related Items menu often contains pictures, sounds, and tables
that relate in some way to the text. On the Audubon's Birds CD, for
instance, for each document that contains Audubon's original notes
on the bird, the Related Items menu contains the birdsong (CD audio)
and a picture of the bird. Related items can be tables of information,
can display ti picture and play audio at the same time, and any other
number of things.
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Viewing Pictures
Since the discQuest CD's were originally made for the Macintosh and
IBM PC, the pictures on them are large and have many colors.
d i s c Q u e s t s u p p o r t s t w o m e t h o d s o f v i e w i n g t h e s e p i c t u r e s :
"grayscale", which is the fastest and provides best detail, and a color
rendering which provides reasonable color representation on the
JIGS moni tor. d iscQuest a lso a l lows the user to scro l l these large
pictures with the mouse. When a picture is viewed, it takes over the
entire screen, so scrolling is smooth and quick (especially with an
accelerator). Clicking the mouse button once will stop viewing the
picture and return to the document you were viewing (or to the
Browse window if you selected a picture from there).

O v e r v i e w / H a l f S i z e
You can get an "overview" look at the picture, if it'is larger than one
screen, by pressing the space bar. The picture will be displayed half-
size. Pressing the space bar again will restore the full-size display of
the picture. Note that half-sizing a color image results in "color
mashing"; i.e., the resultant half-size picture will not have the same
colors, and may look odd.

While displaying a picture, you can switch between the two different
rendering methods (grayscale, or black and white) by pressing the
following keys:

'G' - switch to grayscale
' C - s w i t c h t o c o l o r

Color rendering results in a (obviously) colorful image, although some
detail is lost. Grayscale rendering produces the most detailed images.
Grayscale is automatically chosen whenever you wish to print an
image.
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Play ing Aud io
On many of the discQuest CD's, there are Browse directories which
contain lists of audio samples. Since these samples are CD-quality
audio, to hear them you must have speakers or headphones plugged
into the CD-ROM drive itself. You cannot listen to audio samples
through the IIGS' built-in speaker.

If you purchased the discQuest bundle, you have a set of external
speakers. Unlike many audio speakers, these speakers' magnets are
sh ie lded , and a re spec ifica l l y fo r use on compu te r sys tems .
(Unshielded magnets can cause permanent distortions on computer
monitors and erase disks!).

Almost all CD-ROM drives have 1/8" headphone jacks on the front of
the case, where you can plug in headphones or amplified speakers
such as those shipped with the discQuest bundle. Some CD-ROM
drives also have "RCA" audio jacks on the back of the unit, to allow
you to connect the CD-ROM to a home stereo amplifier.

Some items will play audio automatically when you bring them up
(some pictures). Some audio tracks are played by choosing "Hear
XXX" from the Related Items menu or opening an audio item from
t h e B r o w s e w i n d o w .

On most CD-ROM drives, the audio track will be started and will play
to completion unless interrupted. While the audio is playing, you can
c o n t i n u e t o r e a d d o c u m e n t s o r l o o k a t t h e l i s t o f i t e m s i n t h e S e a r c h
or Browse windows. Generally, opening a new document or moving
to a new directory in the Browse window will cancel audio playback.
However, on some hardware configurations (Apple SCSI Card and
App le CD-150 ) aud io p l ayback i s mo re r es t r i c t ed as f a r as
"background playing" of the audio is concerned.
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P r e f e r e n c e s

You can change certain default behaviors of discQuest by editing the
discQuest preferences. Choose "Preferences" under the "Edit" menu
at any time, and the following window will appear.

Rendering controls whether images are initially displayed in Color or
Grayscale. You may still switch between modes with the keyboard
commands discussed in "Viewing Pictures". The default is Grayscale.

Size controls whether images initally are displayed half-size or full-
size. Again, you can change this with keyboard commands when
viewing the picture.

Finally, Image Scrolling allows you to choose the method by which
mouse movements cause the picture on the screen to move. Window
mode is the default; moving the mouse up (forward) will move the
display "window" towards the top of the picture (resulting in the
image moving down on the screen). The other scroll mode is "page"
mode; moving the mouse up (forward) causes the "page" the image is
on to move up (resulting in the image moving up on the screen).

Preferences are stored in the file "DQ.Prefs".
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Troubleshoot ing
W h e n I ' m i n t h e F i n d e r a n d I i n s e r t a C D - R O M i n t o t h e
d r i v e , n o t h i n g a p p e a r s .

RamFAST: Run the RamFAST util ity program (see the RamFAST
manual) and choose "SCSI Utilities" from the menu. Make sure that
the CD-ROM drive appears in the list of SCSI devices. If it does not;

• Make sure the CD-ROM drive is powered on before you turn on
y o u r c o m p u t e r .
M a k e s u r e t h a t t h e C D - R O M ' s S C S I I D d o e s n o t c o n fl i c t w i t h t h e
SCSI ID of another device on your SCSI chain

If the CD-ROM drive does appear in the list of SCSI devices:
• Make su re t ha t you r RamFAST has Ve rs ion 3 .01e o f t he

RamFAST firmware (the first screen in the utility program will
tell you this). If you need a ROM update, you can order one
from Sequential Systems' toll-free sales line.

C h e c k D r i v e r s a n d F S Ts :
• Make sure that you proper ly insta l led the High Sier ra/ ISO

9660 FST (File System Translator) onto your hard drive. Look
i n t h e " S y s t e m : F S Ts " f o l d e r f o r " h s . f s t " .

• I f y o u h a v e a n A p p l e S C S I c a r d , m a k e s u r e t h e
" S y s t e m : D r i v e r s " f o l d e r o n y o u r h a r d d i s k c o n t a i n s
"SCSI.Manager" and "SCSICD.Driver".

• I f y o u h a v e a R a m F A S T S C S I c a r d , m a k e s u r e t h e
"System:Drivers" fo lder contains "RamFAST.Driver" .

You can install drivers either by using the discQuest "Hard Disk
Installer" diskette, or by using the System Software installer to place
the "Drive: CD-ROM" package on your hard drive. If you have an
Apple SCSI card, you must use the System Software installer
(discQuest does not come with the appropriate Apple SCSI drivers).
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d iscQues t says "Unab le to l oca te d i scPassage CD" on s ta r tup

• See "In Finder Nothing Appears" above.

• Make sure that the CD you are attempting to use is in fact a
"discPassage" CD-ROM. These CD's almost always have the
"discPassage" logo on them. discQuest is not needed for CDs
that are IIGS-specific or have IIGS-specific files on them (such
as the Apple Developer Group CD-ROMs).

The on ly SCSI dev ice on my SCSI card i s the CD-ROM dr ive ,
and I have c rashes or the CD-ROM is no t recogn ized.

RamFAST: if you boot straight into GS/OS (with a System
Software boot disk other than that provided by Sequential) the
RamFAST will crash about half-way through the boot. If you
then "warm reboot " (p ress Cont ro l -OpenApp le-Reset ) the
system will boot properly. The only workaround is to first boot
directly into ProDOS 8 (which is exactly what our standalone
boot disk does).

• Apple HS or Rev C SCSI: the Apple SCSI cards will normally
only work with a CD-ROM drive if there is also a hard drive on
the SCSI chain. The Apple SCSI card manual discusses a way to
work around this by changing the card's SCSI ID.
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Appendix A: Printer Drivers

discQuest has been tested with the following printers and drivers:

ImageWriter (I & II) Apple Image Writer Driver
V i t e s s e P e r f e c t - I m a e e

HP DeskJet Series Vitesse Harmonie. Seven Hills Independence
S t y l e W r i t e r A p p l e S t y l e W r i t e r D r i v e r
L a s e r W r i t e r I l f A p p l e L a s e r W r i t e r D r i v e r

I n s t a l l i n g D r i v e r s

The floppy-based vers ion o f d iscQuest comes wi th the App le
ImageWriter driver pre-installed. If you wish to print to any other
type of printer (or to a printer on a network) you will have to run
the System Software "Install" disk or the "Install" disk of the third-
party drivers you use to copy the proper drivers onto the discQuest
d i s k .

You should do this only to a backup of the discQuest diskette (see
Introduction for instructions on how to make a backup disk).

Many of the pictures on supported CD titles are complex images, and
do not print well on an ImageWriter with Apple's standard driver.
We recommend Vi tesse 's "Per fect Image" ImageWri ter dr ivers,
which allow the user to finely control many aspects of printing color
images. Vitesse may be reached at:

V i t e s s e , I n c .
P O B o x 9 2 9
L a P u e n t e , C A 9 1 7 4 7 - 0 9 2 9
( 8 1 8 ) 8 1 3 - 1 2 7 4
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Appendix B: Supported Graphics Types
discQuest has the capability to display several different types of
graphics files that appear on the supported CD's. These are:

A d o b e T I F F

Topix '.SCF (formerly RIX-Works)
W i n d o w s . B M P

The graphic images (often 640x480 pixels) are read into memory.
The 256 entry color palette is converted to a 16-color (or 16-level
grayscale) palette, and each pixel in the image is remapped to that
new palette. This process is written in assembly language and is
very fast, even on an un-accelerated Apple IIGS.

.BMP files appear only on the 3rd Edition Family Doctor CD-ROM.

Note that discQuest itself can only display these types of picture files
if they are on a discQuest CD-ROM disc. Sequential may produce a
standalone graphics file viewer program in the future.
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T o s h i b a 3 4 0 1 - 2 0 0

D R M - 6 0 0

-n-No known problems.
*l-No CD audio in discQuest(digitized audio on the Encyclopedia will
work okay). _
*2-Must reboot to put in a new CD.
*3-Requires special driver from Tulin.
* 4 - N o A u d i o C D ' s .
*5-Requires special SCSI-2 Driver from Sequential for audio support.
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Appendix D: installing the Media Control drivers
You must have a hard disk, or a floppy with about lOOK free, to use
the Media Control drivers, and also must be using a RamFAST SCSI
card (a CD-150 driver for the Apple High Speed SCSI card comes with
the IIGS System Software). These drivers allow you to play standard
audio CD's in your NEC, Sequential, or Apple CD-150 CD-ROM drive.

Run Ins ta l l e r f r om the "Ha rd D r i ve I ns ta l l e r " d i scQues t d i sk , and
install the "Media Toolkit" item on your hard drive. When you have
done that, you will be asked to reboot your computer.

When the computer has finished booting, you need to set up the
Media drivers. Open the "Control Panels" accessory (under the
colored Apple menu).

= i l = f : n n t r n l f n n » U

f)

Keyboard

Media Ctrl

Modeii Port

t OPfn 1

1 f I

J 2 . 1

Locate the "Media Ctrl" panel, click on it with the mouse, and then
click the "Open" button. You'll see the following:

=□= M e d i o C t r l !

Select 0 Medio Channel;

< S ) 1 0 2 0 3 0 N
0 5 0 6 0 7 0 8

Select a Medio Device:

.CVTECH.S5.F li o

.CVTECH.S5.G
GAME PORT

1 MODEM

[ Cleor Chonnel ]
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Make sure that Channel 1 (one) is selected (it will show in Red text).
In the top list, choose the type of CD-ROM drive you have ("Texel" is
the Sequential "discQuest CD-ROM Drive"). In the bottom list, choose
"GAME PORT"; nothing is actually connected to your game port of
course; these drivers automatically locate your RamFAST/SCSI card,
but something must be selected here.

Note: If you are configuring for an Apple CD-150 and have an Apple
High Speed SCSI card, you must choose ".APPLESCSI.CDROM.OX" in the
ports list. Only the RamFAST drivers (RF.NEC, RF.CD150, RF.TEXEL) do
n o t n e e d t o h a v e a n o r t s e t u d .

Close the "Media Ctrl" window. At this point, you are ready to pla>
audio CD's. Put a CD into your drive, open the "Media Controller" desk
accessory (under the colored Apple menu), press the Play button
(marked with a '>' .) , put on your headphones, and enjoy your
favorite music while you compute!
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Glossary
CD-ROM "Compact Disc - Read Only Memory" . CD-ROMs are

based on Sony's compact disc technology and are
also "read-only", meaning that one can retrieve data
from CDs but cannot change or add information to
them, like a floppy disk or hard disk.

F S T S h o r t f o r " F i l e S y s t e m T r a n s l a t o r " . A G S / O S E S T
allows GS/OS to access new types of "File Systems".
For example, the ProDOS FST allows GS/OS to access
Apple II ProDOS disks, and the HFS FST allows
G S / O S t o a c c e s s M a c i n t o s h d i s k s . S e e " I S O 9 6 6 0 " .

H igh S ie r ra See " ISO 9660"
I S O 9 6 6 0 I S O 9 6 6 0 ( a l s o k n o w n a s H i g h S i e r r a ) i s t h e

industry-standard file system used on CD-ROMs.
While CD-ROMs can be made with any file system
(such as ProDOS or Macintosh HFS), most CD-ROMs
a r e I S O f o r m a t . Y o u m u s t h a v e " H S . F S T " i n s t a l l e d i n

your System Software to use these CD-ROMs.
Mu l t imed ia Mean ing "many types med ia" . Genera l l y re fe rs to

software that mixes audio, still pictures and text,
and movies or other animation. Many CD-ROMs are
" M u l t i m e d i a " .

S C S I ( p r o n o u n c e d ' s c u z z y ' ) " S m a l l C o m p u t e r S y s t e m
Interface"- an industry standard way of connecting
fast peripherals to a computer. SCSI adapters or
interface boards (like the RamFAST or Apple High
Speed SCSI card) are required for an Apple II to

_ use SCSI devices.
S C S I - 2 A n e w e r v e r s i o n o f t h e S C S I s t a n d a r d , t h a t i n c l u d e s

standards for playing audio CD discs, making it
easier for software to support. Most double speed
drives made today are SCSI-2. Ask your vendor or
reseller for specific information on this.
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